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Hard to believe, but we are now half way through the decade when it seems like yesterday was

New Year's Day, 2000. This is the month we remind members it is renewal time once again, and

enclosed with this November issue is a stamped, self-addressed envelope for your convenience in making

renewing easy. Thanks to careful comparison-shopping, and other fiscally responsible managerial

endeavors, both Emil Volcheck, Jr., and Richard Savoy have made it possible to keep our

membership dues at the same levels as last year: $15 US in continental U.S., $17 US in Mexico and

Canada, and $25 US at all other locations across the globe. If you lose the enclosed envelope, just send

your check to Emil Volcheck, Jr., 1046 General Allen Lane, West Chester, PA, 19382-8030.

This month we are sad to announce the death of Jeffrey Puffer, who was a member in the 1990's,

then he had joined again recently. Jeffrey's obituary is on page 14.

Since it will be several months before our new BIO's are printed, you might want to grab your pens

and your most recent BIO, to make note of a new member, as well as a new address. Member Jack

Rothweiler's new address is P.O. Box 837, LaPine, OR 97739-0837.

Our new member is: Ken Paul, 8022 Raven Oaks Drive, Omaha, Nebraska, 68152. His

occupation is in Nuclear Power Plant Security, his computer systems include C64 w/SCPU, C128,

Loadstar HomeTower, FD2000, 1541, 1571, CMD Hard Drive, Cannon BubbleJet Printer, and

Magnavox-compatible printer. Some of Ken's interests include transferring GOCUG (Greater Omaha

Commodore User's Group) archives to CD-ROM, constructing C64 Towers, and building C64 home

controllers. Let's everyone give a hearty welcome to Ken and hope he will feel at home right away!

Three Commodore events on the horizon should be mentioned. One is the TPUG World of

Commodore to be held December 3-5, 2004 in Toronto. Member Bruce Thomas has details. Then the

LUCKI EXPO is planned for May 13-15, 2005 in the Louisville area; member Dale Sidebottom has

information. Finally, July 30-31, 2005, is the tentative date(s) for the CommVEx planned for Las

Vegas, NV. Non-member Robert Bernardo has posted preliminary information about it online.

Lastly, if you notice an occasional line of text that resembles some new 6- or 8-point font, squeezed

down in the vertical direction till it is barely legible, it is actually the product of my still-misbehaving

Lexmark Optra 40 printer, which will be replaced as soon as possible.

u^ Hope you enjoy this issue and I encourage all to try your hand at editing at least once. Enjoy.

-Linda Tanner, President



BUSINESS OFFICERS:(addresses in BIO's)

PRESIDENT : Linda Tanner, tannerlj@yahoo.com

Handles group business, compliments, complaints, threats, etc.;

VICE-PRESIDENT: Francis Redmond, redinc@earthlink.net;

sends "late" reminders;

TREASURER: Emil Volcheck, Jr. emilv@mercury.ccil.org receives

dues, donations, balances bank account, disburses monies;

MAILINK-ON-DISK EDITOR & MAILER: Richard Savoy;

RSavoy5578@aol.com;compiles and archives MaiLink On Disk and

arranges for photocopying and mailing of CML;

ARCHIVIST and MANAGING EDITOR: David Mohr,

lordronin@videocam.net.au; oversees receiving, maintaining and

copying CML archives; backup editor;

MEMBER BIO EDITOR:Brian Vaughan:

frogissam@neteze.com; edits member addresses and BIO's; denotes

member as "Friendly Correspondent" in BIO's at member request;

E-DDRESS EDITOR: JosephFennJfenn@lava.net;

(jfenn@lava.net); maintains email addresses of members;

WEBMASTER: Anjdrew Schwartz, andyschwartz@hotmail.com;

maintains MaiLink website, http://mailink.videocam.net.au;

QUESTION & ANSWER MAN: Rolf Miller,

rolfmiller@aol.com; he answers C= questions!!

YELLOW PAGES EDITOR: Jorge Pedreira,

edar43@abaconet.com.ar; maintains resource lists of C= oriented

products and services; produces March/September Yellow Pages.

THE EASY WAY TO CONTACT OFFICERS:

president@MAILINK.videocam.net.au

vicepresident@MAILINK.videocam.net.au

treasurer@MAILINK.videocam.net.au
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webmaster@MAILINK.videocam.net.au

managingeditor@MAILINK.videocam.net.au

diskeditor@MAELINK.videocam.net.au

editor@MAILINK.videocam.net.au

COMMODORE MAILINK POLICIES and RULES:

The Commodore MaiLink (CML) is published every other month by

Meeting 64/128 Users Through the Mail, copyright 2004 by Meeting

64/128 Users ITirough the Mail. All rights reserved. Permission given

to reprint if credit is given to the Meeting 64/128 Users Through the

Mail. The names, "Meeting 64/128 Users Through the Mail" and

"Commodore MaiLink" and "CML" are also copyrighted. Any and all

opinions expressed in this publication are the views of the authors, and

in no way necessarily reflect the viewpoints, attitudes or policies of

Meeting 64/128 Users Through the Mail, unless so stated or indicated.

Neither Commodore MaiLink nor Meeting 64/128 Users Through the

Mail condones piracy of copyrighted software or other material. All

programs published arc with the permission of the author, or are to the

best of our knowledge, in the public domain. Software offered for sale

is said by the seller to be either public domain, or if commercial, is the

original disk with original documentation. All manuscripts or any

material for review or publication should be sent to the editor of the

next issue. Commodore MaiLink reserves the right to edit

submissions.

Members may place free Commodore BUY/SELL/TRADE ads in the

MaiLink. Send diskfile of ad to next editor.

EDITOR GUIDELINES: (abbreviated version))

Editing a newsletter involves collecting articles, programs,

and other items, then placing these items in printed newsletter

form. An editor may opt for the "cut and paste" approach,

where articles, once printed, are literally cut and pasted onto

each "master page". Or, publishing software may be used.

Editor should where possible use the two-column per page

format for better readability. Also, all page margins should be

no less than 3/4 " on each right and left margins. Text,

regardless of which font, should, with rare exception, be 12

point or larger. The number of different fonts on a page is not

written in stone, but no more than two is a good rule of thumb,

or three if you include footers and/or headers.

Requirements for the Editor include, if submitted,

BUY/SELL/TRADE ads, Treasurer's Report, Obituaries,

Announcements, Address Changes, and New MemberBIO's.

Also the Editor must detail the computer system, including

software and hardware and printer used in the production of the

current newsletter, as well as name, requirements, and deadlines

of next editor. This could be in two separate columns: "The

Editor's Desk" and "The Next Editor". If as Editor, you

receive more than enough to fill pages 3-18, you will publish all

"requirements" and -1 some of the "options", and forward to

next editor only whatever "options" would not fit in newsletter.

The Editor should edit each item as it arrives, creating a

diskfile and a backup diskfile, making certain a TWS version of

all disk files is (also) created. A good, clean "master copy " on

single, unfolded sheets, printed on one side only and protect^

by cardboard should be sent along with the TWS disk files to

our Mailer, Richard Savoy, by the first day of the month you

are editing. NOTE: to include a color page, send 130

completed sheets of that page, printed on both sides (ready for

insertion into CML), along with the "masters" and TWS disk.

A second copy ofCML (copied on the back ofjunk mail is OK)

should also be sent to the President for proofreading purposes.

Always keep your backup disk in a secure place until the

MaiLink is in the hands of members. If you suddenly realize it

is near the first of the month, and you arc not nearing

completion of the newsletter, notify the President. It is much

easier to deal with a problem if it is made known.

Editing can be fun. It can be mentioned in your resume', so

what are you waiting for? Contact us now.

NOTE: pages 1,2,5 and 6 of this newsletter were created

with a C128, SCPU, CMD HD, RamLink, Lexmark Optra 40 PS

II printer, geoWrite, geoPublish, Wheels, and PostPrint 3, by

-y .... Linda Tanner.

November Editor: Robert Snyder
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JEWISH MUSIC ANYONE?

by Kenneth Barsky

/—s I am probably the only person in the country that has SIDized Jewish and

Hebrew folk songs and liturgical music. Some are with .WDS, translation

and transliteration. The only piece I ever saw that was SIDized was

"Hava Nagilah", and not such a good job at that, either.

If there is anyone in the club who is Jewish, or who could or would

appreciate such music, I would be willing to share. I'd ask $1 for

copying and shipping. Contact me at KBarsky@msn.com or snail-mail me. My

address is in the membership list.

THE CQMPLEAT LOADSTAR COLLECTION ON CD-ROM NOW AT SALE PRICE

by EditoROB Snyder

I just received a letter (and cd) fran Fender Tucker and he has lowered

the price on his Compleat Loadstar CD for MUTTM members to only $20!

Everyone who EVER used a carcnodore 64 should get this CD; I really mean

iti It includes everything Loadstar published from 1984-2001. You can

use the CD directly to turn a PC into a 64 computer or you can transfer

the files onto a real 1541, 1581, or and equivalent. You have the entire

"Loadstar Universe11 at your keyboard. You can not go wrong. I bought the

first one and have gotten several since— updated for myself and for

others of our club. I cannot stress enough that everyone should get

one.

Here's what's on the CD:

* .d64 files of all 199 issues of LOADSTAR * .d64 files of all 42 issues

of LOADSTAR 128 * .d64 files of all 19 issues of UpTime (a rival disk

magazine) * .d81 files of every "product" ever published by LOADSTAR

outside its monthly issues — games, puzzles, music, art, recipes, chess

problems, the flags and anthems of every country on earth, all four of

the ProseQuest literary contests, and more. * JPGs of all of the 76

color covers that LOADSTAR had when it was sold on newsstands * TXT

files of over 160 of the issues, allowing you to use your PC's word

processor to search for keywords * a complete collection of all 76 of

the LOADSTAR Letters (Jeff Jones'superb newsletter) on the CD in PDF

format, ready for printing with Acrobat Reader (downloadable) * VICE 1.9

- the best CormDdore emulator for the PC which allows you to enjoy the

issues almost exactly as if you had a fast C-64/128 under your

fingertips.

* THE COMPLEAT KNEES CALHOON Song Library. Over 250 MP3s, including the

60 songs Knees wrote during his 20-year career as guitar picker, plus

all sorts of other songs never heard by human ear (outside the Calhoon

Cult).

Price is now only $20 U.S. including shipping in the USA. Outside the

US, how about $23? fender@loadstar.com

Fender Tucker, 443 Gladstone Blvd., Shreveport, LA 71104, USA.

Commodore Mailing tyvemB&r, 2004,



UNITED WE STAND

by EditoROB Snyder

As this is the last issue for this

year, it is time for all of us to

stick together as cormodore 64/128

users and reup our membership in

Meeting 64/128 Users Through The

Niail (MUTTM). Surely, $15 (for

U.S. members) is not a lot tc

spend to help keep us informed of

how to get more out of our

computers. MUTTM is the largest

group I knew of to find help with

all things corrnodore. We all need

YOU as a member. After all, our

club's best resource is its

members. I have already sent in my

dues; send in yours today.

HOW THIS NEWSLETTER CAME ABOUT

by EditoROB Snyder

As for the actual preparation

of the newsletter, I used a

c=128D, RairiLink, HD, 1581, and a

Cormodore MPS 1101 daisywheel

printer. I did use a PowerMac to

send/receive emails with Eudora

Pro 4.0 and ClarisWorks 3.0 to

switch the emails into ascii text

files. I saved the files on a DD 3

1/2" disk where I then went to

Comnodore. I used Little Red

Reader to transfer to commodore

format with my 1581 and a 1581

partition on my HD. My word

processor of choice was The Write

Stuff 128 v2 with spell checker

for text writing and layout.

WHAT I WOULD LIKE TO SEE IN 2005

by EditoROB

The following is a list of suggestions frcm manbers about what topics they

would like to read about in upcoming issues of the MaiLink. I was

disappointed in the volume of submissions. The few submissions I did

receive, must mean that the membership is happy with the mix of articles

that have been included in the past. I'm sure if members have suggestions

for future articles in the future, the editors and officers would be glad to

hear about it anytime.

One thing I've been wanting to read about is WINGS, the OS being developed

by Jolse (M ) of Australia, and used and pranoted by Canadian Greg Nacu,

Greg has written some apps for it and usually is doing something with it at

most EXPO's.— Linda Tanner

... Another nice thing about members submitting articles is that it takes

some of the pressure off the editors, who usually have to scramble to find

enough stuff to fill an issue (sometimes}.— Linda Tanner

I would like to see articles about using; Fun Graphics Machine; step by step

like Bruce Thanas does for GeoPublish, jbne Voskamp-Jones does for GEOS, or
Arndt Dettke does for GoDot. I wonder if; there are collections of templates

for doing things such as newsletters, labels and the such. Ages ago, I saw
the ads for PGM in the magazines and newsletters and longed to buy it. I

finally received the program and book (roistered user's version B156) when

I acquired another family's entire canmdlore collection. With all the talk

about GODOT on the COPS list, I thought cibout doing that, but then thought,

"why not spend my time with PGM! It is nore tuned to my cannodore setup.11 —

Robert Snyder

Commodbrv 9dmBt^ November2004, page 4



BASICALLY SPEAKING
(by Linda Tanner)

We continue our discussion of spritemaking begun in September and discuss those spritemaking duties that are

applicable to all BASIC programs using sprites. I have tried to pattern most variables in "Spritesampler2" after those

variables used in "Spritesamplerl" as a learning aid for novice programmers.

The one-byte-per-sprite data pointers (see p. 133-34, C-64 Programmer's Reference Guide) reside in 2040-2047

which are screen memory locations set aside for these pointers, but we must still tell our Commodore which number

between 0 and 255 to place there. I use 192 through 199. In September's "Spritesamplerl" the first half of statement

10 POKEs these values into their respective pointers. Then, the second halfofstatement 10, plus statements 13 and 15

READ data from the data statements and POKEs it into the appropriate memory locations. Then beginning with

statement 19 you will notice a bunch of POKE statements. POKESS+39 through POKESS+46 statements merely

assign sprite colors. POKESS+21,255 in line 23 enables all sprites simultaneously. Then POKESS+29,255 and

POKESS+23,255 cause all sprites to expand horizontally as well as vertically. POKESS,24 and POKESS+6, 255

assign locations for the "X" co-ordinates of sprites 0 and 3, respectively. The POKE'S in line 24 assign "X"

co-ordinates for sprites 4,1,2,5, and 6, respectively. In line 26 the POKE'S assign an "X" co-ordinate to sprite 7, and

"Y" co-ordinates to sprites 0,2,3, and 1, in that order. Finally in line 27 the "Y" co-ordinates for sprites 4,5,7, and 6

are assigned, then the screen in unblanked. You may wonder if all these POKE'S seems cumbersome, but remember

we have 8 sprites, and the computer has to be told specifically the "X" and "Y" co-ordinates in order to place them on

the screen. Note in line 6 that SS=53248. Now look on page 321 of your Commodore 64 Programmer's Reference

Guide and you will see how much easier sprite positioning looks. The Commodore has already reserved the sixteen

memory locations 53248 through 53263 for the eight "X" and eight "Y" co-ordinates of each of our eight sprites.

Now that our sprites are positioned, we can move them if we like. In September's program we move only one

sprite, but at the same time, we change colors of our sprites randomly. You will see in statement 30 of September's

"SPRITE SAMPLER 1" that we move sprite # 1 horizontally (FORAA= 194TO231 :POKESS+2,AA:NEXT) then we get

a random number for color (GOSUB42) and POKE it into various of our sprites in lines 30, 31, and 32. In line 36

we finally move our sprite #1 back where it was before we moved it. Then in line 40 we "GOTO30" which starts the

cycle anew. I could have incorporated a STOP, but in a teaching example as this, it is OK to leave it to the user to hit

the STOP button after viewing or studying the sprite movement.

In this month's program on page six, we create two sprites, one being a vehicle, and the other being a wall which

the vehicle hits. This little program demonstrates for the beginning programmer simple left to right movement of a

sprite, along one path, toward one specific target. There are many more exciting ways to accomplish sprite

movement, but we must take "baby steps" before we can create and pilot spaceships through the galaxy!

In "SPRITESAMPLER2" this month, we have a few new variables, SE, SH, and SV, which are actually

acronyms: SE for "Sprite Enable", SH , "Sprite Horizontal Expand", and SV, "Sprite Vertical expand". In line 6,

we first blank the screen, then we POKE the number zero into 53280 and 53281. What are these numbers? They are

two of the VIC II chip's 47 Control Registers. The screen's border color is controlled by a number between 0 and

15 that is POKEd into 53280. Likewise for the screen area inside the border whose color is controlled by 53281. The

47 control registers, 53248 through 53294 are listed on pages 321-323 of Commodore 64 Programmer's

Reference Guide.

Statement 8 reads the data statements 100 through 106 containing the 63 data elements that define sprite #0, and

then POKE this "Sprite Zero Data" into the location reserved in memory for it. Similarly,for sprite # 1 in line #9, we

read data from statements 108 and 110, then POKE it into its appropriate memory locations, as we did for Sprite #0.

In the first portion on line 10 we are dealing with "sprite data pointers" exactly as described above for our September

program. In line 10 of "SpriteSampler2" we "enable" both sprites via POKESE,PEEK(SE)OR3.

In line 12 we assign colors to both sprites, then expand sprite #0 horizontally with POKESH,PEEK(SH)OR1, and

sprite # 1 vertically with POKESV,PEEK(SV)OR2. In statement 13 we assign "X" and "Y" co-ordinates to sprite 1,

our "wall", then in line 14 we "unblank" the screen, then assign "X" and "Y" positions for sprite #0, our car. Finally,

we drive our car into the wall with FORA=24TO230:POKESS,A:NEXT (continued on page 6)

Commodore MaiLinf^ 9{gvemSer, 2004, page 5



BASICALLY SPEAKING, continued from page 5

"SPRITESAMPLER2"

(for the C64 without SCPU, or with SCPlPs TURBOspeed disabled)

4SS=53248:Y=53265:SI=12288:E=.:SE=SS+21:SH=SS+29:SV=SV+23:B=192:P=2040

6 POKEY,PEEK(Y)AND239:PRINTCHR$(147):POKE53280,0:POKE53281,0

8 FORII=1TO2:FORI=.TO62:READQ:POKESI+I,Q:NEXT:S1=SI+64:NEXTII

10FORA=.TOl:POKEP+A,B+A:NEXT:POKESE,PEEK(SE)OR3

12POKESS+39,7:POKESS+40,13:POKESH,PEEK(SH)OR1:POKESV,PEEK(SV)OR2

13 POKESS+2,255:POKESS+3}124

14POKEY,PEEK(Y)OR16:POKESS,24:POK£SS+U50:FORA=24TO230:POKESS,A:NEXT

16FORA=lTO2000:NEXT:POKESE,PEEK(SE)AND(252)

43 REM-C64 SPRITESAMPLER2-(DISABLE SCPU TURBOSPEED) NOV04 CML-BY LINDA TANNER

100DATA0,0,0A0,0M0,0,0,0,0,0,0
102DATA0,255,0,0,129,0,0)129)0)0,129,0,63,255,252

104 DATA33,255,132,109,255,182,19,255,200,18,255,72,12,0,48

106DATA0,0,0,0,0,0,0,0,0,0,0,0,0,0,0,0,0,0

108DATA0,0,7,0,0,7,0,0,7,0,0,7,0,0,7.0,0,7,0,0,7,0A7,0,0,7,0A7,0,0,7

110 DATA0,0,7A0,7A0,7A0,7A0,7A0,7A0,7A0,7A0,7A0,7

Next is a slight upgrade.. In the routine below, our car crashes into the wall, knocking it to the ground, causing a small

"crash"-ing sound. Here we created four separate sprites, the car, the upright wall, the wall in mid-fall position, and the

wall on the ground. Immediately after the car hits the wall, that sprite is disabled, and the next sprite, the partially fallen

wall, is enabled, then shortly the process is repeated as the falling wall is disabled and the wall lying on the ground is

enabled. Plus in addition to the extra sprites to represent the falling wall, we have added the small sound effect. The

versatile SID chip is an entire course of study, which we'll visit at a later time in more depth. Ifyou look carefully at each

step in the order it appears, you will see how the program works. Both programs are on Nov. MaiLink-On-Disk.

"SPRITESAMPLER2A"

4 SS=53248:Y=53265:SI=12288:E=.:SE=SS+21:SH=SS+29:SV=SS+23:B=192:P=2040

5 Z1=54272:Z2=54296:FORA=1TO24:POKEZ1+A,.:NEXT

6POKEY,PEEK(Y)AND239:PRINTCHR$(147):POKE53280,.:POKE53281,.

8FORII=1TO4:FORI=.TO62:READQ:POKESI+I,Q:NEXTI:SI=SI+64:NEXTII

10FORA=.TO3:POKEP+A,B+A:NEXT:POKESE,PEEK(SE)OR3

12POKESS+39,7:POKESS+40,15:POKESS+41,15:POKESH,PEEK(SH)OR9:POKESV,PEEK(SV)OR6

13POKESS+2,230:POKESS+3,124:POKESS+4,255:POKESS+5,124

14POKEY,PEEK(Y)OR16:POKESS,24:POKESS+l,150:FORA=24TO210:POKESS,A:NEXT

16 POKESE,PEEK(SE)AND(253):POKESE,PEEK(SE)OR(4):GOSUB40

17 POKESE.PEEK(SE)AND251

18POKESS+42,15:POKESE,PEEK(SE)OR8:POKESS+6,255:POKESS+7,146:GOSUB41:GOTO42
40FORA=lTO100:NEXT:RETURN ;

41POKEZ2,15:POKEZ1+1,6:POKEZ1+5,25:POKEZ1,34:POKEZ1+4,129:POKEZ1+6,6:RETURN
42 FORA=1TO100G:NEXT:POKESE,PEEK(SE)AND2^0

43 REM-C64 SPRITESAMPLER2A-(DISABLE SUPERCPU's TURBOSPEED) NOV04 CML by Linda Tanner
NOTE: to save space we omitted lines 100-110 which are identical to those in "Spritesampler2".

112DATA0,48,0,0,96,0,0,96,0,0,192,0,0,192,0)l,128Al,128,0,3A0,3,0A6A0
114DATA6)0s0,12)0)0,12,0,0,24,0A24,0)0,48J0)0,48,0,J,96,0A96)0,0
116DATA192.0A192A0

118DATAO,0)0)0,0,0,0,0,0,0,0,0,0,0,0,0,0,0,0,0,0,0,0,0,OiO,0,0,0,0,0,OAO,0,0
120DATA0,0,0,0,0,0,0,0,0,0,0,0,0,0,0,0,0,0,0,0,0,255,255,255,255,255,255

Commodore MaiLinlQ ^gvemSer, 2004, page 6



QUESTION & ANSWER DESK

Rolf Miller, Q & A editor rolfmiller@aol.ccxn

Qaestions may be submitted by regular or e-mail. Answers will be

returned as soon as obtained, then published in coming issues, though

the identity of those asking questions will not appear because

duplicate, similar, and associated items will be compiled.

Q, I need to add a routine to an existing program that will convert

screen code to ASCII and vice versa without a lot of programming. Any

ideas?

A. It is assumed that by "without a lot of prograrrcning," the reference

is setting up arrays to act as conversion tables between the two codes.

Yes, there is another way.

The conputer "sees" what is displayed as ASCII values though it is

represented in screen memory as screen code. So, printing a character to

the display using its ASCII value, then peeking its screen memory

location will yield its screen code. For illustration, run the

following.

10 PRINT CHR$(19)CHR$(65):PRINT PEEK(1024)

Printing CHR$(19) hones the cursor, effectively placing it at the first

address of screen manory (1024), and CHR$(65) displays the letter A, 65

being its ASCII code. Thus, printing PEEK(1024) displays its screen

code, 1.

Conversely, poking screen code to screen memory will display its

corresponding character, then reading the display as a file will yield

its ASCII code. To see it, run these three lines.

20 POKE 1024,2 30 OPEN 1,3:PRINT CHR$(19); :GET#3,D$:CLOSE 1 40 PRINT

ASC(D$)

The screen code for the letter B is 2. So, poking 1024 with 2 displays B

at the hone position. Then, OPEN 1,3 opens the display (device 3) on

channel 1 for reading. Because reading the display begins at the

cursor's position, it is honed by printing CHR$(19); the semicolon

preventing a carriage return which would otherwise cause the cursor to

jump to the next line. GET#3,D$ reads the first character into D$ and

CLOSE 1. Then printing ASC(D$) displays the character's ASCII value,

66.

Hopefully, incorporating these techniques into the existing program will

accomplish the desire. u

THANKSS1V1NQ

Commodore MaiSn^^fovem$er2004,



FUTURE COMMODORE EXPO

by Bruce Thomas

been a very inportant part of the

success of the computers.

At the LUCKY EXPO in May there was

Dale Sidebottom's "favorite hour of

the year' on Sunday morning when

attendees sat around and discussed

possible ways to enhance and improve

on future EXPOs ,(although as a first

time EXPO-goer I'd say it would be
hard to iirprove on what Dale and the

rest of the local LUCKY members put

on this spring).

The big idea that I seized upon and

came hone with also sprang from the

fertile young mind of Seth

Sternberger when he stated that, in

his profession, they have annual

conferences but the events are

staged in different parts of the

country so more people get a chance

to attend a 'local" event.

I have wanted to attend an EXPO for

quite a few years. We held some very

successful shows in Edmonton in the

late 80 's and early 90 's. While they

were a lot of work to put on they

were also very enjoyable and brought

the members of the club who worked

on the event much closer as a group.

This year I was very lucky that I

was able to work out the

arrangements to attend the LUCKY

EXPO when Todd Elliott proposed that

I do the premiere demo for his

geoPublish VI.1. dice again, it was

a lot of work to prepare for my

demos and it took a lot financially

to get to Louisville but I am very

happy that I took advantage of the

opportunity when it came along. To

be able to finally meet so many of

my Carcnodore friends that I have

only known through mailing lists, e-

mail and the odd phone conversation

was fantastic. There were also so

many other people that I met who I

had heard of before but never really

connected with. It makes it so much

easier ncv/ to chat with these people

or drop an e-mail to them since we

have met face to face. The social

side of Commodore Clubs has always

Which takes me back to the point

about roving EXPOs.

When I returned home I started

looking into User Groups in the

Western US. I contacted a few people

to see how active they were. One of

the people I contacted was Robert

Bernardo. This worked out great as

Robert was planning a trip north in

the suirmer. During his stop in

Edmonton he stayed at my house for a

couple of days. We talked a lot. Did

some touristy things. Saw a ton of

CornxxJore equipment at my buddy

Bob's places. And we talked a lot.

A big topic was an EXPO out west. It

turned out that Robert would also be

traveling to Las Vegas later in the

summer and he would check into some

options while he was there. Robert

also came up with a possible name.

Here is a little history.

11 Ccnriex traces its roots to a

casino owner who launched the

Computer Dealers Exposition in 1979.

Four years later a young Bill Gates

delivered his first keynote speech

and demonstrated Microsoft's new DOS

2.0. Although it grew to become one

of the biggest trade shows in the

world, at its peak attracting more

than 200,000 attendees and filling

more than 1 million square feet of

floor space, Comdex's fortunes have

sagged in the past few years as the

tech economy faltered and security

jitters kept some companies from

traveling. "

So, what Robert came up with was

ConmVEx - Cdnmnodore Vegas Expo.

While in Vegas Robert met up with

Hernan Vergara who works ,at a place

with a very large room that would be

perfect (and cheap) for an EXPO.

There is a reasonably priced hotel

just down the road. Things are

EXPO continued next page

Commodore Mai&n^ t pO0* 8



FUTURE COMMODORE EXPO (cont)

starting to come together, Vegas has

plenty going for it. There are

usually cheap flights fron most

places to get there. Hotels can be

fairly cheap. It is out west where a

different group will have easier

access to attend.

Up to this point a fair number of

people have been involved in

discussions. Dale Sidebottom and

Randy Harris have provided input and

their thoughts on running an EXPO.

Dave Ross (also of SWRAP) has talked

with Robert B about the EXPO. Al

Jackson and the 5C's Coirmodore Club

in Las Vegas have said they could be

counted on to provide enough

hardware for demo's so that people

wouldn't have to lug whole systems

across the country. Quite a few

people have been asked for their

opinions on whether or not they

would attend such an event.

So far the responses have been quite

positive and I think that a great

deal of excitement will build in the

ccming months.

One of the things behind this effort

was not to disturb the existing

EXPOs. I think that Dale Sidebottom

and the LUCKY Club and Randy Harris

and Dave Ross and Robert Schwuchow

and the SWRAP Club have been doing

exceptionally well with their EXPOs.

It's just that I (and a lot of

others) can't afford to go that far

every year.

We have the upecming TPUG World of

Cormodore show on December 3-5, 2004

in Toronto. Still a fair distance to

go for me. Dale is planning the

LUCKY EXPO for May 13 .- 15, 2005. I

have not heard about plans for the

fall Chicago SWRAP 2005 EXPO yet but

I believe they want to continue

their tradition.

I just got off the phone with Robert

Bernardo (temporarily disabled after

an accident at work - he can't type)

and he agreed that it is time to let

the cat out of the bag.

CommVEx 2005 is tentatively planned

for July 30-31, 2005 in Las Vegas,

Nevada.

I'm not sure if this will be the

start of an annual event or not. It

would be great if the back drop of

Las Vegas could provide a place for

hundreds of Commodore Users to

gather and share and enjoy each

other's company for a weekend. There

is still a lot of planning to be

done to make this show a reality.

But we have to get started now

because of that old saying -

"Objects on the Calendar are closer

than they appear".

We are going to be looking for

people with interesting Cormodore

software, hardware and activities to

put on demos. We are going to be

looking for volunteers to help set

things up, man the

ticket/registration table, pick

people up at the airport/hotels,

etc.

So, if you want to be part of

something really great; if you want

to attend the first big Commodore

EXPO in the Western United States in

this millenium; if you want to demo

your latest Commodore related

invention; if you have Conmodore

related products for sale and would

like to set up a table with your

wares, Please get in touch with

Robert Bernardo or myself and let us

know what level of participation you

would like to have. The event can

only get better and will only be as'

good as the participants make it.

Please mail membership

renewals by December

20th!

&tai^



BONE OF CONTENTION

by Rolf L. Miller

In the September 2004 issue, Brian

Vaughan said he corrpletes tasks

more quickly with his Ccnrnodore

system than he could on the PC. I

showed his words among

acquaintances to prove that I am

not the only one in the world who

says this. They all with one

accord responded with remarks

alluding to old dogs.

Well, aging mutts can still sniff

out stinkers, and the fact is that

ALL tricks are new to puppies.

After all, these young doggies

have never experienced a

Cormodore.

To put things in perspective, the

64 setup on this desk is used to

produce mostly plain-text

documents, print mailing labels in

the hundreds, and prepare a

variety of datum utilized in other

applications pertaining to ongoing

daily activities. There are also

several PC's in this household,

mainly for internet access, the

oldest being a 486 running Windows

3.1 and the newest being the

wife's recently acquired 2.3Ghz

Dell running XP. The proposition,

therefore, is that one of these

PC's could accomplish the office

work faster.

Naturally, all these young mutts

agreed on the Dell, dismissing the

486 as obsolete. However, as the

whelps contemplated the work to be

achieved, first one, then another,

backed away fran the affirmative,

reluctantly conceding that they

didn't know how to perform many of

the tasks on a PC. In other words,

the proposal is that I spend time

learning how to do on a PC what

the 64 already does in order to

save time.

Spending hours to acquire know-how

so work can be accomplished faster

makes sense only if at sane point

the hours saved by the faster work

exceeds the hours spent.

Certainly, when it canes to speed,

even the 486 outruns the

Commodore. But that fact does not

necessarily translate into faster

results. The Hertz rating of a

computer, for example, is not a

measure of finger speed on the

keyboard.

OK, spell checking on a PC happens

quicker. An interesting aspect of

PC's, though, is that the gains

which new machines give in one

area are often taken back

elsewhere because of bloated

software. For instance, the wife's

machine does a lot of things

faster than the 486, but when it

cores to going on line to get

email, the Dell takes

significantly longer.

The 486 is also equiped with an

X1541 cable to accormodate cross-

platform needs. The pups saw this

setup as the bone to pick. As one

of the pooches contended, "There

is no way that transferring stuff

is faster than just doing it on

the PC."

In the arena of polemics,

reasoning of this sort is called

begging the question. It is an

argument which assumes the very

point to be proved. To do it

faster on the PC assumes using the

PC to do it, something these

puppies already admitted they

mostly didn't know how to do.

NEXT EDITOR

I can take articles until December 15, in most

Commodore formats, ASCII, GeoWrite and

standard PET-ASCII. Files can be sent to:

David Mohr, 623 29th Street, Astoria, OR

97103 or Email: lordronin@videocam.net.au
Long articles please send on 3.5" or 5.25"

disk Deadline is December 15th.

{Mwm6er 2004, &*& 10



PRINTER DRIVER by Jack Rothweiler

[EditoROB: Here is an article that was sent to me the last time I did

the MaiLink. I passed it on but it was never included in a future

issue., until now; here is Jack's tip]

I did think of sending a printer driver that I had which works on 128 or

64 and seems to always work on anything • When I listed it I found that I

had typed it in fran Run magazine (Run 12/88 ,Page 12). After 4 lines of

rem statements"the file is only 2 lines. It is very short and efficient.

1 RIM TEXT FILE READER, RUN 12/88 PG12, C64 OR C128

2 REM READ SBQ.FILES TO SCREEN OR PRINTER-

3 REM ALSO READ PRG. TEXT FILES

4 REM PAUSE 64=ANY KEY -128 USE NO SCROLLS REM USABLE AS SUB-ROUTINE

10 INPUT "FILENAME11 ;F$:INPUTHPRINT Y/^%-R$:D=3:IFR$="Y"THENI>=4:S=7

20 OPEm/8,2/F$+%M/R^OPEN4/D/S:PiaNTllANOrHER Y/NII;Q$:IPQ$=5"YIITHEN1O

I-PAINT/I-PORT AVAILABLE FROM RICK KANE by Robert Bernardo

My old, original disk of I-Paint sat there forlorn. It was vl.3, not the

latest version, and I had never gotten I-Port either. Would I still be

able to purchase them fran Rick Dane, the creator of these programs?

I-Paint was a 80-column paint program for the flat C128 modified with a

64k vdc or for a C128DCR (which already came installed with a 64k vdc). '

I-Paint itself was based off of BASIC 8 routines developed by David

Darus and Lou Wallace* However, I-Paint was unlike any other C128 paint

program including BASIC 8's Basic Paint, I-Paint ran in interlace mode,

giving a 640x400 screen. From the old days of Ccmnodore magazines, the

advertisements mentioned that your I-Paint artwork would have the

appearance of thousands of colors (though in interlace mode, there would

be screen flicker, depending on the colors chosen). I-Paint pics

appeared in the download libraries of the GENIE and Delphi on-line

services. Converters were developed to transfer I-Paint pics to/fran

GEOS. Cne of these converters was I-Port, which converted between I-

Paint and GIF.

Now, after all these years, I wanted to upgrade. Could I? First, I made

inquiries on conp.sys.cbm as how to contact Rick Kane. Lo and behold, I

was sent his e-mail address, and I sent Rick a message. A few days later

he responded. Both I-Paint and I-Port are still available from him!

His most recent version of I-Paint is vl.5h. Current pricing is $40, I-

Port $20, both for $50. To upgrade, if you have an original I-Paint or

I-Port disk, include it in your order and deduct $15 for I-Paint disk

and $5 for I-Port disk. He accepts check or money order, made out to

Rick Kane. Shipping is included. His contact information is—

Rick Kane

Living Proof Software n

PO Box 80714 <—iS^
Minneapolis, MN 55408-8714 £X M
rickkane@att.net \j£ju
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GEOPUBLISH TUTORIAL PART 7

Importing More Articles

By: Bruce Thomas

In geoPub5 (it will be on Page 10 ofthis tuto

rial) we imported our first geoWrite file into

geoPublish. We learned about gutters, how to

set the regions, how to 'pour' our text into the

regions and how to ripple our text. We looked

at two methods to create space for a headline

as well as how to re-size our regions to make

the most efficient use of space.

This time around we are going to import the

rest of our articles up to this point. We are go

ing to use different page layout formats, gutter

sizes and a variety ofjustification settings. All

of this will provide you with a wide range of

visual styles as well as good practice at im

porting text files. For future articles I will in

clude a separate file on the web site outlining

the regions that you should create for proper

importing of the article.

When we finished importing our article in

geoPub5 we were done with the layout of

Page 2 of our Tutorial. In order to continue,

choose 'next page1 in the Options menu. Click

the OK button when asked if you would like

to create the next page.

Our first article showed what pages look like

if you use a 2-column layout. We

also left the Gutters at the default value of 5

all around. For the majority of

the rest of our articles we want to use a value

of 10 for the left and right

gutters. Select 'set gutters' in the Options

menu and set 10 point left and

right gutters.

For geoPub2 we will use a 3 column layout.

Since Page 3 is the first page for a new article

we need to layout the page with a region for

the headline (large) and 3 for our columns.

In order to make it easier to describe the layout of

our text regions pay close attention to the follow

ing page diagram and chart. The Guidelines

shown are the ones we created in geoPuM.

When we are working on a Left Page (even num

bered) I will refer to the Vertical Guidelines as A,

B, C, D and E. When we are working on a Right

Page (odd numbered) I will refer to the Vertical

Guidelines as V, W, X, Y and Z. In both cases

the Horizontal Guidelines will be referred to as 1,

2, 3 and 4.

NOTE: The geoWrite file contains an embedded

graphic here..

Labels for the Horizontal Guidelines:

Label Position Label Position

1 1/2" 2 1"

3 1 1/2" 4 101/4"

Labels for the Vertical Guidelines:

Left Page Right Page

Label Position

1"

3 26/80"

4 1/2"

5 54/80"

8

When I talk about setting a region I will say to se

lect the Region Tools and set region from 1A to

3E. This would create a Large Headline Region. If

we have a Left Page with a small headline region

using the 3 column format the middle region

would go from 2B to 4D. A Right Page with a

large headline using the 2 column layout would

have a right region going from 3X to 4Z. In in

stances where we have to create custom columns

they will be referenced by the appropriate

labels paired up with measurements - 3A to 6"C

would indicate the left region on a left page using

a 2-column layout where the region ended at the

6" vertical mark. This region would likely be

paired with a second region from 6"A to 4C. I

hope this naming convention is clear and easy to

understand.

Continued on Page 13

Label

A

B

C

D

E

Position

1/2"

2 66/80"

4"

5 14/80"

7 1/2"

Lab

V

W

X

Y

Z
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GEOPUBLISH Continued from Page 12

While in Page Layout Mode ensure Snap is on

(Options menu or C= S) and select the 'Open

Region' [gP 3-11] tool. Create our first region

across the top of the page (IV to 3Z). This is our

Large Headline region and will be used to start

all of our articles.

We next want to create our three text regions us

ing the narrow guidelines. Set text region 1 (3V

to 4W) then text region 2 (3W to 4Y) and finally

text region 3 (3Yto4Z).

With our regions set the way we want we can

now select the Text Placement' tool [gP 3-11]

and choose our geoPub2 article in the list. After

pressing the Open button click your mouse in

the three regions across the page from left to

right and then ripple the text with the 'SHOW'

button. Page 3 is complete as far as Page Layout

mode is concerned so create the Next Page in

the Options Menu. For Page 4 (RightMaster) we

still want to use 3 columns but we only need the

Small Headline region this time. To create the

Small Headline region choose the 'Open Region1

tool to set this region (1A to 2E). Next create

text region 1 (2A to 4B), text region 2 (2B to

4D) and text region 3 (2D to 4E).

After creating the regions use the 'Text Place

ment1 tool and import geoPub2 into the 3 regions

from left to right across the page. Ripple the text

with the 'SHOW' button and you will notice that

column 3 is not completely fall. This is

OK. We may fill it up later.

In order to import geoPub3 we need to create

another new page (RightMaster). In Page Layout

mode for this article we want to create 3 regions.

Create the Large Headline region (IV to 3Z) and

then text region 1 (3V to 4X) and text region 2

(3X to 4Z).

Import and ripple the remainder ofgeoPub3 onto

Page 6 and then create Page 7.

We will begin geoPub4 on Page 7 (RightMaster).

Create the layout with the Large Headline region

(IV to 3Z) and 2 columns (3V to 4X; 3X to 4Z).

Page 8 (LeftMaster) will utilize the Small Head

line region (1A to 2E) plus 2 text regions (2A to

4C; 2C to 4E). In order for our text to fit we have

to set the bottom gutter in the second text region

(2C to 4E) to a value of zero either before or after

importing the text. The Small Headline region

(IV to 2Z) on Page 9 (RightMaster) will top the

page over our 2 text regions (2V to 4X; 2X to 4Z).

We now get to a point where our text does not end

neatly at the bottom of a page. In order to finish

importing geoPub4 we need to use some space on

Page 10. Start Page 10 (LeftMaster) in the normal

fashion with a Large Headline (1A to 3E). Create

two text regions to begin geoPub5 using the fol

lowing areas (3A to 5 3/4"C; 3C to 5 3/4"E).

Next we need to create 2 more regions to hold the

remainder ofgeoPuM (5 3/4"A to 4C; 5 3/4"C to

4E). Once you have created these 2 lower regions

we need to create some space for a Small Head

line and 'continued from' text. Highlight each of

these 2 regions in turn and set the Top Gutter to a

value of 36.

In a case like this where we are using an odd

measurement (you have to use the cursor keys to

set 5 3/4") an option is to go into Master Pages

Mode and set another Guideline. You could desig

nate this Guideline as a 'floater' and adjust it to

wherever you need it on any given page and it

would save having to use the cursor keys to set 4

regions.

Now we can import the rest of geoPub4 into the

two lower regions. Once you have done that im

port geoPub5 into the top two regions and then

Ripple the text. Create Page 11 (RightMaster) and

make a Small Headline region (IV to 2Z) and 2

text regions (2V to 4X; 2X to 4Z) then import and

Ripple more of geoPub5. The remainder of

geoPub5 will go onto Page 12 (LeftMaster) with a

Small Headline region (1A to 2E) and 2 text re

gions (2A to 4C; 2C to 4E). Continued on Page 14
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Import and ripple the geoPub3 article and then

create Page 6 (LeftMaster). Again we will use

the 2-column format so create the Small Head

line region (1A to 2E)

plus 2 text regions (2A to 4C; 2C to 4E).



GEOPUBLISH Continued from Page 13

For Page 13 (RightMaster) we need a Large

Headline region (IV to 3Z) and two full length

article regions (3V to 4X; 3X to 4Z). Import and

Ripple geoPub6 onto this page and then create

Page 14.

Page 14 (LeftMaster) will be similar to Page 10

in that we need to have some overflow room for

the remainder of geoPub6. Make a Large Head

line region (1A to 3E) and 2 text regions (3A to

6"C; 3C to 6ME) to start geoPub7. Create 2 more

text regions (6MA to 4C; 6MC to 4E) and set the

top gutter value in each to 36 to have room for a

headline.

Import geoPub6 into the lower 2 regions, import

geoPub7 into the upper 2 regions and Ripple the

page.

Next we need to create Page 15 (RightMaster) to

import more of geoPub7. We need a Small

Headline region (IV to 2Z) and 2 full-length text

regions (2V to 4X; 2X to 4Z) for the article.

Create these and then import and ripple

geoPub7.

Create Page 16 (LeftMaster) to import the rest of

geoPub7. We need a Small Headline region (1A

to 2E) and 2 full-length text regions (2A to 4C;

2C to 4E). Create these and then import and rip

ple geoPub7.

Now that we have created all of our text regions

in our first geoPublish document I'll show you

an easier way to do this. In the Options menu

choose 'goto page1, type 1 and press Return

From the File menu choose 'library1, press the

'Create' button, type TutorialPage' and press the

Return key. This is very similar to the Library

function we used in Master Pages Mode.

Type 'Rt2ColLrg' and press the Save button.

Your first Page Layout has been saved to the li

brary. From the 'options' menu select 'goto page',

enter 3 and press Return. From the File menu

choose'library1 and then highlight the first

'empty' word. Type 'Rt3ColLrg' and press the

Save button.

Choose 'next page'

from the 'options' menu to go to page 4. Select

'library' from the 'file' menu,

highlight the first 'empty', type 'LfiColSml' and

press Save. Goto page 6 from

the 'options' menu, open the 'library' from the

'file' menu, highlight the first

'empty ', type fL£2ColSml! and press Save. Goto

page 9 from the 'options' menu,

open the 'library' from the 'file' menu, press the

down arrow and highlight the

first 'empty ', type 'Rt2ColSml' and press Save.

We now have 5 of our Page Layouts saved to a

Library file. As we go along we

will now use these Page layouts where we can

instead of creating the regions

from scratch every time. We will also add any

new Page Layouts to the library.

Next time we will take a look at Editor Mode

and some ofthe tricks that can be

used to squeeze more text onto a page.

Until then, enGEOy your Commodore!

OBITUARY
Jerry Puffer, father of fellow member Jeffery

wrote that he had passed away on the morning

ofAugust 14th. It was just one year and a week

from when he was first diagnosed with lym-

phoma. Even during his suffering he never la

mented about, "why did this terrible thing have

to happen to me."

I've known Jeff since he first joined the group

in the early 90's when I sent him a "Welcome

Letter" we became "Pen Pals" right away and

he was by far the person that wrote to me the

most, at times like brothers even thought our

age difference was about 40 years. He loved his

Iowa Prairie and talk about it often as well as

the outdoor life and had the good fortune to

work out doors most of his working days. He

loved his Commodore and when he developed

problems, in the late 90's, and nobody to repair

it in his area, he packed up, sent most of it to

me and went to the PC. Last year he asked me

about re-joining the group to get the Mailink

and did. The letter he wrote to Linda Tanner, is

in the March issue of the Mailink.

—Richard Savoy

Commodore Waiting November2004, (Page 14



THE BEST of BOTH POSSIBLE WORLDS

- PART 2 -

By: Kenneth Barsky

In the last issue of Mailink I

discussed how it is possible to

simulate the Commodore 64 and 128

on your PC to get The Best of

Both possible worlds..

I mentioned two programs you will

need to download and where to ob

tain them. In this article I will

discuss how to use them.

A program that converts 1581

disks (which I use) to .D81 disks

and visa-versa. I use 64cl581c

which is a combination of 64copy

and 1581 prepared as such and

available from Dave Moorman at

LOADSTAR on line at:

http://www.eloadstar.com/pctower/

freedls.html

The file as downloaded is a Win-

Zip file named 1581CP54. When

you dissolve it a folder called

64C1581c will appear in My Docu

ments, Find the file, click on it

and maneuver (or search for) a

file named 64main. Right click,

select properties, Screen, Full

Screen, OK. Next change the icon

to 64copy (in folder) and send a

shortcut to Desktop.

When you run the program you will

see two listings. One listing is

My Documents and the other is

64cl581c in My Documents. At the

top each column the first item is

a double period.

Next is a black and white DOS in

put screen. The ESCAPE key tog

gles back and forth to a full DOS

screen.

At the bottom is a list of

function keys that you can press

or click on.

Now the prompt screen should

start with

C:\MYDOCU"1\ 64C1581C\D64Copy>

If it doesn't then click on the

double periods of the 64C1581C

copy listing.

Now you are ready to copy a 1581

disk.

A word about the disk first.

1. It helps if the first pro

gram is a menu or the pro

gram you want to run.

2. No HD disks or FD2000 par

titioned disks.

Put a Commodore 1581 disk into

PD drive A. To prompt described

above add 1581copy a: name.d81

and enter.

Note ; lower case; watch spac

ing, "name" does not have to be

the name of the disk you are

copying - use any short name

yjatat you cab identify later.

The program will make a copy of

your disk, Hopefully without bad

sectors.

I have found that if the disk

does not copy cleanly a MCOPY of

the disk might copy cleanly.

Now you will see the disk image

listed in the 64cl581c. Now

click on that file and click orm

or press F6 Rename/move. Now you

can change the name, or do so

later. The disk copy is move to

my documents.

Continued on Page 16
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Continued from Page 15

When you have copied all the

disks you want leave 64COPY by

clicking on or pressing F10

Quit; follow prompts; click on X

minature DOS screen, and you

will be back in Desktop.

Go to My Documents and find the

disk images that you just cop

ied. You can rename the files

now, if you haven*'t done so al

ready. It is also a good idea to

organize your disk images

(which we'll now call .D81

files) into folders of similar

items. I have folders, for exam

ple, called LOADSTAR, MALINK,

D.81 GAMES, D.81 MUSIC etc.,

etc.

Now back to 64 copy. To make a

1581 disk of a .D81 image;

1. Move the D81 file back to

64C1581c listing

2. Put a blank DD disk into PC

drive A

3. To prompt add 1581copy

name.d81 a: /f

And the disk will be formatted

and the .D81 files will be cop

ied.

Now, personally I don't use this

method, which I will explain in

another article.

These are the features of 64COPY

I use. Dave Moorman uses more

features, as he describes:

XF-Keys — Let me see. The

ones I use all the time

<INSERT> Mark File names for

Copy/Remove

<F5> Copy marked files from one

column to the other

<F8> Remove marked files

<F7> Create new SubDirectory

<F10> Quit 64Copy

<F12> Create new disk image (D81,

D64, etc.)

<Shift-F2> Go to disk image di

rectory manager <Insert> Mark

files

<F3> Move marked files to above

where cursor bar is

<F10> Quit image directory man

ager

<Shift-F7> Put line in directory

<Alt-Fl> Change drive (C:, D:,

etc) on left column

<Alt-F2> Change drive on right

Column

<TAB> Move between columns

There should be a list at the

bottom of the screen that gives

some clues about the F Keys.

Press Shift, Ctrl, or Alt to see

other possibilities."

In my next article I will discuss

VIC and how it reads and runs .

D*! files.

THE WRITE STUFF

EMBEDDED (RVS) COMMANDS

First press Control 1 format:

a Alternate pagination

b Boldface toggle

c Centering toggle

d Double-width

e Emphasized print

f Forced page

i Italics toggle

j Justification toggle

1 Linked file

m Margin release

n Non-printing note

q LQ/Draft toggle

r Right alignment

I will continue to add

more ofthese com

mands for the TWS

word processor in fu

ture issue.

See my Column on the

next page.

Richard Savoy
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THE WRITE STUFF

WORD PROCESSOR

COLUMN BY: RICHARD SAVOY

ARTICLE NO. 9

h,Sh-H,@ Hunt & Replace

Hunt can be used to find a word or phrase.

Used with Replace, it is similar to Search & Re

place. The difference is that Hunt stops and

waits when a match is found.

Let's say you've written a report about cars.

You've used the word "auto" throughout and de

cide to change it to "car." If you're not careful, a

word

like "automatic" may become "carmatic." So tap

CTRL, press SHIFT-H, type "auto" then SHIFT-

@, and "car." With the cursor at the start of

your text, press h to hunt. If "auto" is found,

press @ to replace it; otherwise press h again.

You can hunt for reverse video

characters by tapping CTRL to toggle RVS in

put on & off.

Enter a phrase in lower-case and press SHIFT-

RETURN for a case less hunt.

Ls Load/Save

To LOAD a file: put the cursor at the top of

the text, tap CTRL and press 1.

To MERGE: position cursor, enter command

mode and press 1.

To APPEND: put the cursor at the end of your

text-tap CTRL, press 1.

To LOAD a Speed Script, Easy Script, or sev

eral other word processor files:

input file name and press SHIFT RETURN.

To LOAD/SAVE to tape: put a "t:" in front of

the file name (e.g. t:name)

. To READ/WRITE a sequential file: add a ",s"

to the end of the file name. Add ",p" or ",u" to

READ/WRITE a PRG or USR

file. With the ASCII toggle, you can READ

SEQ and USR files.

/V/v LOOKING FOR THE

NEXT EDITOR?

TRY PAGE 10

For auto-SAVEs, add the file name as anon-

printing note to the very beginning of your text

(e.g. @0:-file name).

muSh-M Macros

Macros are just abbreviations for words and

phrases. Any one or two characters can be de

fined to equal any word or phrase up to 250

characters in length.

For example, "x" is not a word, so it could be

defined to equal "example." With macros on,

every time you type "x(SPACE)ff "example "

pops out-saving six key strokes. A single key

could be defined to equal your entire name and

address.

Tap CTRL and press SHIFT-M to define a

temporary macro (e.g. B=Busy Bee Software).

Load and edit the file "bb macros" to make per

manent changes. Read the tutorial on macros

for more help.

=,Sh-F,k Misc. Commands q,Sh-+

Tap CTRL and press = for an approximate

word count. The number of bytes used and

bytes free is also given.

In BB Talker, CTRL,SHIFT-F toggles the F

keys between use for speech processing and for

moving the cursor by word/sentence/paragraph/

screen.

CTRL,k toggles key click on/off.

CTRL,Sh-PLUS creates a second text

area in BB Writer. CTRL,q toggles

between the screens.

That's it for this issue, next time we will have

"Print/Review", "Screen Format" "Search & Re

place" and "Sorting Columns."
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C64 COMPUTERS FOR FREE JUST PAY

SHIPPING

by J, Sears S.R.E.Services, Coirputer

Repair

I have to clean house or the wife

will throw me out. I have 10 or more

C64s I need to give away to a good

hone. Einail address is

jsears@rvg.rr.com

Other stuff available free too, no

monitors.

I live in South Ttexas (HARLINGEN)

NEAR BROWNSVILLE AND SOUTH PADRE

ISLAND. I am not in a big hurry but

can't wait forever ether. I even

have several original boxes. The

1541 drives are limited and of

course very old. I have a box of

pcwer supplies (old bricks). These

C64 were in a private school that

got a donation of Dells from the

Imnoigration service. I also have

several paper boxes of educational

software, likely the most complete

in the country, again free for

shipping. Please pass the word. I am

not getting rid of everything, just

the excess I built up over the years

since 1985 we I got started.

INDEX

Title Page

Ads/Buy/Sell/Trade/Giveaway....18

Basically Speaking 05-06

Best of Both Worlds pt2 15-16

Bone of Contention 10

Compleat Loadstar CD 03

GeoPublish Part 7 12-14

How This Newsletter Came About.04

I-Paint/I-Port 11

Index 18

Jewish Music Anyone? 03

MaiLink Officers and Policy....02

Meeting News Cover

Obituary 14

Printer Driver 11

Q & A 07

TWS Column: Article 9 17

TWS (RVS) Conmands 16

United We Stand 04

West Expo 08-09

What I Would Like to Read 04

MORE FREE ITEMS!!

For a give away I do have a large

set of GEO's in original boxes, or

anyone interest, like your self!

Free including shipping! I will

never use now I 'm using BBR to

convert from IBM to Carmode, just to

old to start it. Contact info for

Richard Savoy is in the members

bios.

CINCINNATI COMMODORE COMPUTER CLUB

Official Users Group Number 292

c/o 31 Potowatomie Trail

Milford, OH 45150

www.geocities.con/c64~128-Amiga

cbmusers@yahoo. con

The Cincinnati Commodore Computer

Club has 1000 's of used comnercial

items for sale at very reasonable

prices. The lists include software,

hardware, accessories, books,

magazines and manuals. Because of

the low prices we ask that buyers

pay postage. For a 5 1/4" disk of

the lists, send a floppy mailer to
Roger Hoyer, 31 Potowatomie Trail,

Milford, OH 45150. If you'd rather

receive the lists by Email, contact

Roger at thunderbird@iglou.com or

the club at cbmusers@yahoo.com. A

third alternative is to view than

and download them from our web site-

www,geocities . can/c64-l28-amiga .

The club also sells the following

printer tractor feed items:

3.5" x 15/16" address labels in

pastel shades of blue, green, pink

and yellow, plus white - $1.00/100.

2.75" x 1 15/16" labels for 3.5"

disks - $1.50/100.

3.5" x 6" postcards - $1.50/100.

Prices include postage.

YOUR MEMBERSHIP RENEWAL

It is Important to be mailer early, if

for no other reason than to know the

number of renewal members before the

end of the year, so we can plan on pur

chase of materials & services


